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EinfUhrung 5
Giris

Belirli bir alana odaklanan literatlr incelemesi, bircok bilimsel alanin temel unsurunu olusturmaktadir. ilgili
alanyazinin sistematik bir sekilde analiz edilip sunulmadig bir projeye ya da teze denk gelme ihtimalimiz oldukga
dlsuktir (Creswell, 2016, pp. 58—66). Her gecen giin artan sayida yayinevinin, dergileri ve makaleleri cevrimigi
erisilebilir hale getirmesiyle, literatiir taramalarinin olusturulmasi daha kolay ve etkin bir hal almistir. MAXQDA,
literatQr taramalarinin olusturulmasi (6rnegin, teori bélimlerinin ve arastirma raporlarinin hazirlanmasi) ve
sistematik incelemeler ile meta-analiz calismalarinda arastirma sonuglarinin hazirlanmasi gibi literatiir ile ilgili
gindelik isler i¢in olduk¢a uygundur. MAXQDA, 6zellikle notlarin organize edilmesi ve ydnetilmesi ile aragtirma
sUrecini desteklemek icin dzetlerin olusturulmasi amaciyla kullanilabilir. Literatiir Gizerine ¢alisirken, bibliyografik
bilgiler (yazar, yayin yil gibi) literatir igeriginden ayri degerlendirilmelidir. MAXQDA genellikle icerige odaklanir ve

referans yonetim programlarinin sagladig 6zellikleri sunmaz. Ancak, referans yénetim programlarindaki veriler
MAXQDA programina aktarilarak tzerinde gesitli islemlerin yapilmasi mimkundiir.

Bu kilavuzda:

e Bibliyografik veriler ve tam metinler ile calisma

e Referans yonetim programlarindan ve (¢evrimici) veritabanlarindan veriyi iceri aktarma
e Literatlr ve 6zetler ile ilgili gnlUk igleri yerine getirme

e Literatlr taramasi yapma ve

e Sistematik incelemeleri gerceklestirmek igin mimkiin olan segenekler Gzerinde durulmaktadir.
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Referans yonetim programlarindan bibliyografik veriler ve tam metinler
ile calisma

MAXQDA, kullanicilara Mendeley, EndNote, Citavi ve Zotero gibi referans ydnetim programlarindan bibliyografik
verilerin iceri aktariimasi firsatini sunmaktadir. MAXQDA programinda oldugu gibi bu referans yénetim
programlan toplanmig olan tiim bibliyografik verileri iceren proje dosyalarini, yani veri tabanlarini, kullanir.
Boylesi bir projede en kucuk birim bibliyografik kiinyedir (r., yazar, baslik vb.). Bu kiinye internet sitelerine,
anahtar kelimelere, 6zetlere, tam metinlere ve diger bilgilere erisim baglantisi icerir.

MAXQDA, ilgili literatir veri tabanlarindan RIS formatinda disariya veri ¢ikartabilen tim referans yénetim
programlari ile uyumludur. RIS bibliyografik veri igin standart bir format olmakla birlikte Citavi, DocEar,
Endnote, JabRef, Mendeley ve Zotero gibi siklikla kullanilan literatir ydnetim programlarinda kullaniimaktadir.
Boylece, bu programlardan secilen literatlrl veya ilgili literatirin tamamini igeren girdileri MAXQDA
programina aktarabilirsiniz. Literatiir kiinyesinin yani sira ilgili referanslarin tam metinlerinin de MAXQDA
programina aktarilmasi su programlar ile mimkiindur:

e Citavi (2020 bahar itibariyle ice aktarma fonksiyonu kullanilabilmektedir)

e Endnote
e Mendeley
e /otero

MAXQDA programina aktarildiginda, her bir literatiir kaydi basli bagina bir metin belgesi halini almaktadir. Eger
tam metinler ice aktariimissa, MAXQDA otomatik olarak tam metin ile ilgili literatir kaydinin arasinda bir baglant
kurar. Literatdr kayitlarindaki bilgiler otomatik olarak sonraki adimlarda uygulanacak olan analizler igin kodlanir.
Boylece tim bagliklar veya 6zetler bir araya getirilebilir ve taranabilir. Eklentiler, iceri aktarma suirecinde otomatik
olarak anahtar kelimeler kullanilarak kodlanabilir ve her bir literatiir kaydi icin notlar dokiiman memosu olarak
ilgili eklenti dosyasi ile birlikte kaydedilebilir. Metnin devaminda yer alan gérsel, MAXQDA programinin
referanslari "REFERENCES" (REFERANSLAR) ve ilgili tam metinleri "REFERENCES > ATTACHMENTS"

(REFERANSLAR > EKLER) ice aktarirken belge gruplarini nasil olusturdugunu géstermektedir. Gérselde sadece

bir referans (Bryman 2007) ve ilgili tam metin ek olarak iceri aktarilmis ve kaydedilmistir.
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~ [P REFERENCES
[f Bryman, Alan - 2007
v [ REFERENCES > ATTACHMENTS
Bryman (2007). Barriers to integrating quantitative and qualita

RIS verisi olarak iceri aktarilan referanslar ve ekler icin dosya organizasyon semasi

Bibliyografik veriler icin RIS dosya format

RIS, “Arastirma Bilgi Sistemi” (Research Information System) formatinin kisaltilmig halidir. RIS dosyalari disa

aktarilan tim literatir kayitlarinin birbiri ardina listelendigi basit veri dosyalaridir. RIS dosyalar “etiket” olarak
adlandirilan ve iki harften olusan bilgileri icerir. Onemli etiketlere érnek olarak:

TY — Referans tipi (TYpe of reference), genellikle yeni bir kaydin baglangicini isaretler

ID — Her bir kayit icin 6zgiin kayit numarasi (Unique IDentification number for each entry)
AU - Yazar (AUthor)

Tl — Baglik (Tltle)

PY — Yayin yili (Publication date/Year)

ER — Kaydi sonlandirma (Closes EntRy), her zaman kaydin sonunda yer alir

RIS format etiketleri hakkinda daha detayli bilgi edinmek icin Wikipedia linki ziyaret edebilirsiniz:
https://en.wikipedia.org/wiki/RIS_(file_format). RIS kaynak veri érnegi asagida listelenmistir:

TY
AU
AU
TI
PY
cYy
PB
ER

KITAP

McLuhan, Marshall (ilk yazar)

Fiore, Quentin (lkinciyazar)

The medium is the message: An inventory of effects (Baslk)
1967 (Vil)

New York, NY (Yapn yeri)

Bantam Books (Yaynevi)

Not: italik ve parantez icinde sunulan bilgiler, cevirmen tarafindan okuyucuya kolaylik saglamak amaciyla

eklenmistir.


https://en.wikipedia.org/wiki/RIS_(file_format)
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Citavi, Endnote, Mendeley, veya Zotero programlarindan literatiir verisini diga aktarma

MAXQDA programina literatiir verisi aktarmadan énce, istenilen veriyi kullandiginiz literatiir ydnetim

programindan RIS formatinda disari aktarmaniz gerekmektedir. Citavi, Endnote, Mendeley ve Zotero

programlarinin hepsi igin ilgili veriyi disari aktarmak benzer bir yolla gergeklestirilir.

Citavi'den Veriyi Digsa Aktarma

1. Solda yer alan referans listesinden disa aktarilacak olan kayitlari seciniz. Eger tim referans kayitlarini disa

aktarmayi istiyorsaniz, secim yapmak gerekli degildir.

2. Disa aktarma islemini File > Export > Export> RIS... (Dosya > Disa aktar > Disa aktar > RIS...) ilk asamada
"RIS” filtresini + Add export filter (+ Disa aktarma filtresi ekle) adimi ile eklemek gerekli olabilir.

3. Sonraki asamada, Save to text file: (Dosyayi kaydet:) fonksiyonunu secerek Browse... (Ara...)

fonksiyonunu dosya adini ve kayit yerini belirlemek icin kullaniniz.

Eger ilerleyen asamalarda bu tip disa aktarma islemi gerceklestirmek istiyorsaniz, bu islemi “export

template” ("taslag disa aktar") secenegi ile son adim olarak kaydediniz.

Endnote’tan Veriyi Disa Aktarma

1. Disa aktarmak istediginiz literatiir kayitlarini seginiz.

2. File > Export... (Dosya > Disa aktar...) adimlarini ana meniiden

seciniz.

Bir dosya adi girerek hedef dizini seginiz.

acarak en Ustte yer alan “Select Another Style...” kismindan
cikti stilini arayip ilgili se¢imi yapiniz.

5. Save (Kaydet) butonuna basarak igslemi kaydediniz.

Mendeley'den Veriyi Disa Aktarma

1. Disa aktarmak istediginiz literatiir kayitlarini seginiz.

Dokdman tipini “Text Only” olarak seciniz ve ¢ikti stilini
“RefMan (RIS) Export” olarak resimde gosterildigi gibi seginiz.
Eger bu cikti stili segenek olarak sunulmuyorsa, secim listesini

Save As:| My EndNote Library

Tags:
Where: Literaturdaten E v
Save file as type: Text Only u
Output Style: RefMan (RIS) Export [T}

Export Selected References

Cancel m;
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Ana menUden File > Export... (Dosya > Disa aktar...) secimini yapiniz.

Dosyaya bir ad vererek kayit yerini seginiz.

Dosya tipini “RIS - Research Information Systems (*.ris)" olarak seciniz.

Save (Kaydet) butonuna basarak islemi kaydediniz.

Zotero’dan Veriyi Disa Aktarma

1.

Disa aktarmak istediginiz dékiiman grubunu secip sag tiklayarak Export Collection... (Disa aktar...) adimini

seciniz. Alternatif olarak, ana menUden File > Export Library... (Dosya > Kitiphaneyi Disa Aktar...)

secenegini kullanarak tiim kitlphaneyi disari aktarabilirsiniz.

Karsiniza ¢ikan diyalogda “RIS” formatini seginiz.

Eger notlari ve referansla ilgili dosyalari (6zellikle tam
metinleri) disari aktarmak isterseniz, Export Notes

(Notlan Disa Aktar) and Export Files (Dosyalan Disa
Aktar) ilgili kutucuklarini segtiginizden emin olunuz.

OK (Tamam), tusuna bastiktan sonra bir dosya adi
vererek hedef dizini seciniz.

Save (Kaydet) butonuna basarak islemi kaydediniz.

Format: RIS
Translator Options

Export Notes
Export Files
Character Encoding:

Unicode (UTF-8)

Cancel
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MAXQDA programinda ice aktarma ve otomatik 6n-kodlama

RIS dosyalar “Import > Reference Manager Data” (ice aktar> Referans Yénetici Verisi) adimlari takip edilerek
MAXQDA programina aktarilabilir. ilgili adimlar takip edildiginde RIS veya TXT uzantisi ile secilecek ilgili dosyanin

icinde yer aldigi bir secim kutusu ortaya cikar. igeri aktarma siirecinde, su islemler gerceklesir:

e “Document System” (“Belge Sistemi”) icinde “REFERENCES" (“REFERANSLAR") adi verilen bir belge

grubu olusturulur.

e TUm literatlr kayitlari, yeni olusturulan belge gruplarina bagimsiz veri belgeleri olarak eklenir. Kayitlar

alfabetik olarak siralanir ve kendi sembolleri ile isaretlenir.

e Belge adi, yazarlarin isim ve soyisimlerinin yani sira yayin yili bilgilerini icermektedir. iki yazarl yayinlarda

yazarlar ve isareti (“&”) ile iligkilendirilir. Ug veya daha fazla yazar olmasi durumunda ise sadece ilk yazarin

bilgileri verilir ve diger yazarlar icin “ve digerleri” anlamina gelen (“et a

|B pocument System | (I SJae P 2%

~ [ Documents
~ [l REFERENCES
[ Abe, Ryosuke - 2019
[E Baumann, Martina F. et al. - 2019
[E BIyth, Pascale-L. - 2019
otello, Bryan et al. - 2019
Igharbawy, M. et al. - 2019
|—=\ Janssen, Christian P. et al. - 2019
[E) Javanmardi, Ehsan et al. - 2019
|—=_\_ Kim, Chansung et al. - 2019
E Rahman, Md Mahmudur et al. - 2019
[E) sheehan, Barry et al. - 2019
~ BN REFERENCES > ATTACHMENTS

E Abe - 2019 - Introducing autonomous buses ...
[ Baumann et al. - 2019 - Taking responsibility...

@ Code System &g O I

v  ‘@Code System
~ g REFERENCES
GgRIS
v EgKEYWORDS
4 Autonomous driving

Keywords as Codes

=g Old people

(@¢ Responsibility

(=4 Risk classification

(g Self-localization

(@4 Transportation system
g Trucks

@d Urban area

2 = X

239
217
20
23
19
22
24
20
24
22
21
22
22
2

3

02 = X

239
0

@

]
MNBRNRBMRNNRNMNRBRNOOCG

MAXQDA programina aktarilmis olan literatir

[ Document Browser: Abe, Ryosuke - 2019 jelyC a

.TY_Type of referen §

.TI_Book title {

AU_Author ¢

..PY_Publication yez §

..DA_Date §

.J2_Periodical nam §

VL Volume numbe §
..SP_Start page nun §

..EP_Ending page m §

.L1_Link to PDF §

Ill

) ifadesi eklenir.

a

B P & o X
@

-3

- 3 @

JOUR

Introducing autonomous buses and taxis: Quantifying the potential benefits in Japanese
transportation systems

Abe, Ryosuke Bibliographic information
2019 imported as a text document
2019/08//

Transportation Research Part A: Policy and Practice
126

94

113

Abe - 2019 - Introducing autonomous buses and taxis Quantifyin.pdf

The introd Link to PDF and taxis is expected to generate such benefits as cost
reductions  _.._ __..__._.., .. ._g.—..d| bus operations with a substantial deficit—as well as
enhancing public transit accessibility through decreased trip costs. The purpose of this paper is
to provide an overview of the impacts of introducing autonomous buses and taxis on
metropolitan transportation systems by quantifying the costs of travel in Japan, and to discuss
the potential benefits. First, this study sets the assumptions on autonomous driving
technology, including its impacts on vehicle costs, the decreased labor costs for driving and
safety monitoring in buses and taxis, and decreased driving stress for private car users. Next,
operating costs are computed for autonomous buses and taxis in Japanese metropaolitan areas.
The costs of travel, or the sum of monetary and time costs, are then computed with and
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“Kod sistemi”“nde (“Code System”) “REFERANSLAR"” (“REFERENCES") basligiyla bir kod ve bu kodun
altinda “RIS” ve “ANAHTAR KELIMELER” (“KEYWORDS”) olmak uizere iki alt kod olusturulur. “RIS” kodu, ice
aktarilan dosyalarda kullanilan, 6rnegin, “Referans Tipi” (“Type of reference”) veya “Ozet” (“Abstract”) gibi
RIS etiketlerini alt kod olarak icerir. “ANAHTAR KELIMELER” (“KEYWORDS”) kodu literatiir referanslarindaki
tdm anahtar kelimeleri alt kod olarak listeler.

ice aktarma islemi sirasinda, tiim referanslar otomatik olarak her bir metin béliimd ile ilgili RIS koduna uygun
olacak sekilde kodlanir.

Literatlr referansindaki her anahtar kelime kod sistemi icinde ilgili anahtar kelime ile kodlanir.

DOl linkleri hyperlink olarak metinlere eklenir. Béylece, ilgili yayinin gevirimigi versiyonuna direk olarak
ulasmaniz, gerektiginde, mimkindir.

Eger eklentiler iceri aktariimissa, ayni zamanda su islemler gerceklesir:

“Belge Sistemi” icinde “REFERANSLAR > EKLER" (“REFERENCES > ATTACHMENTS") seklinde bir belge
grubu olusturulur.

Tdm ekler bu belge grubu icine ayri ayri belgeler olarak ice aktarilir.

Belgelere verilen dosya adlar korunur ve ilgili referanslar alfabetik olarak yukari dogru siralanir. Belge
isimlerinin siralanmasi bu nedenle tam olarak alfabetik olmasa da ayni belge isimleri birka¢ kez ortaya
cikabilir; 8rnegin, birden fazla belgenin “icindekiler” bélimi bulundurmasi durumunda oldugu gibi.

Ve eger referanslar ve ekler ige aktarilirsa:

Referanslar ile ekler arasinda ic baglantilar ek olarak olusturulur. Béylece, ilgili belge ve literatiir referansi
arasinda baglanti kurulmus olur. Bu baglantinin kullanicilar igin avantaji literatiir referansi ile tam metin
arasindaki gidis gelisleri kolaylastirmak ve bunu sadece bir tik ile gerceklestirmektir. Literatir referansinda,
kurulan ic baglantiya “PDF linki (L1)” [“Link to PDF (L1)”] béliimiinden ulasilabilir (isimler RIS formatindan gelir
ve ayni zamanda PDF disindaki formatlarda olan dosyalara da uygulanir). Ekte, i¢ baglanti belgenin basinda
yer alir.
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Bununla birlikte, kullanicilarin gelecek segimleri icin 6nemli olabilecek bes gesit bilgi, belge degiskenleri olarak

kayit edilir:

Bu degiskenler sistem degiskenleri olarak olusturulur ve kullanici tarafindan degisken tiiri degistirilemez.

Data editor - All documents

PDDDDDDoDDDD R

RIS_Type (Referans tipi) — metin degisken

RIS_Author (ilk yazar) — metin degisken

RIS_Title (Baslik) — metin degisken

RIS_Reference-ID (Kimlik numarasi) — tamsayi degisken

RIS_Year (Yayin yili) — tamsayi degisken

[ ]

E L I
Document group
REFERENCES
REFERENCES > ATTACHMENTS
REFERENCES
REFERENCES > ATTACHMENTS
REFERENCES
REFERENCES > ATTACHMENTS
REFERENCES
REFERENCES > ATTACHMENTS
REFERENCES
REFERENCES > ATTACHMENTS
REFERENCES
REFERENCES > ATTACHMENTS

Document Variables

2@

Document name
Abe, Ryosuke - 2019

Abe - 2019 - Introducing autonomous ...

Baumann, Martina F. et al. - 2019

Baumann et al. - 2018 - Taking respons...

Blyth, Pascale-L. - 2019

Blyth - 2019 - Of Cyberliberation and F...

Botello, Bryan et al. - 2019

Botello et al. - 2019 - Planning for walki...

Elgharbawy, M. et al. - 2019

Elgharbawy et al. - 2019 - Adaptive fun...

Janssen, Christian P. et al. - 2019

Janssen et al. - 2019 - Interrupted by ...

Her bir belge icin ice aktarilan degisken degerleri

RIS_Type RIS_Author

JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR

Abe, Ryosuke
Abe, Ryosuke

Baumann, M...
Baumann, M...
Blyth, Pascal...
Blyth, Pascal...
Botello, Brya...
Botello, Brya...
Elgharbawy, ...
Elgharbawy, ...
Janssen, Chr...
Janssen, Chr...

MAXQDA ile Literatiir Taramasi

20 Documents

e o
RIS_Title RIS_Year
Introducing autonomous buses a... 2.019
Introducing autonomous buses a... 2.019
Taking responsibility: A responsi... 2.019
Taking responsibility: A responsi... 2.019
Of Cyberliberation and Forbidde... 2,019
Of Cyberliberation and Forbidde... 2,019
Planning for walking and cycling ... 2.019
Planning for walking and cycling i... 2,019
Adaptive functional testing for au... 2.019
Adaptive functional testing for au... 2.019
Interrupted by my car? Implicatio... 2.019
Interrupted by my car? Implicatio... 2.019
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Literatlr verisi ile calisma

ice aktarma ve otomatik &n-kodlamay! takiben, MAXQDA programinda bibliyografik veriye normal metin olarak

erisilebilir. Bu demektir ki ilgili veri aranabilir, kodlanabilir, ilgili oldugu belgelerle baglanti kurulabilir,

diizenlenebilir ve dahasi memolar eklenerek sonraki nitel ve nicel analiz siireclerine hazirlanabilir (Kuckartz &

Radiker, 2019). Bdylece, su sorulari cevaplayabilirsiniz:

Bazi yazarlarin ismi ne siklikla referanslarda gegmektedir?

Hangi konular ele alinmigtir?

Belirli konulardaki yénelimler nasil degismistir?

Daha cok dergi makaleleri mi yoksa belirli bir konuya odaklanan tekyazilar (monograf) mi bulunmaktadir?

Dergi makalelerinin basliklari zamanla ne 6lgiide degisim gdstermistir?

Analizinize baslamaniz icin size l¢ ayri fikir 6rnegi verelim:

1.

Kod sisteminde yer alan anahtar kelimelerden birine farenin sag tusuyla tiklayiniz ve Activate Documents
Containing this Code (Bu Kodu iceren Belgeleri Etkinlestir) fonksiyonunu seciniz. MAXQDA programi
daha sonra bu anahtar kelimenin atandigi tiim ilgili literatiir kayitlarini ve eklerini aktive edecektir.

“Coded Segments” (“Kodlanmis béliimler”) fonksiyonu ile tiim dzetleri agabilmek igin “RIS > Abstract” (“RIS
> Ozet") secenegine cift tiklayiniz. Smart Coding Tool (Akill Kodlama Araci ) fonksiyonunu dzetleri
kodlamak ve sistematize etmek icin arac cubugunda yer alan ayni isimdeki sembole tiklayarak baslatiniz.

“Geri Cagrilan Bolimler” penceresinde tim basliklari listelemek igin “REFERENCES” (“REFERANSLAR”) belge
grubunu ve “RIS > Title” (“RIS > Baglik”) kodunu aktive ediniz. “Geri Cagrilan Bélimler” penceresinde Word
Cloud (Kelime Bulutu) sembollne tiklayarak bagliklarda yer alan (en yaygin) kelimelerin analizine baslayiniz.



14 MAXQDA ile Literatiir Taramasi

MAXQDA ile literattiriin ve 6zetlerin diizenlenmesi ve analizi edilmesi

LiteratUr Gzerinde — hem cevrimici hem cevrimdisi — calismak arastirma ve 6gretim alanlarinda oldugu gibi sivil
toplum 6rgutleri ve enstitller diizeyinde piyasa arastirmalari amaciyla ylritilen en 6nemli aktivitelerden biridir.
Literatir calismalarinda tipik gérevler konu ile ilgili yayinlari bulmak ve okumak, 6nemli noktalari belirlemek ve
isaretlemek, argimanlari anlamak ve metinleri disa aktarmak ile bunlari bir araya getirmek ve karsilastirmaktan
olusmaktadir. MAXQDA programi bu tiir giinliik gérevler ve islemler icin miikkemmel bir aractir. Yaptiklari blog
paylasimlarinda, Elgen Sauerborn (2014) ve Uta-Kristina Meyer (2014), arastirmalari igin ilgili literattird

okurken, 6zetleri ve notlari nasil olusturduklarini ve onlari MAXQDA programini kullanarak nasil organize
ettiklerini aciklamaktadir. Onlarin yaptigi calismalara ve bizim deneyimlerimize dayanarak, su asamalari
Oneriyoruz:

1. MUmkUn oldugunca, arastirmada kullanilacak olan erisilebilir tiim literatiir kaynaklari MAXQDA projenize
aktarihr.

2. MAXQDA programi iginde her bir belge igin ayri ayri 6zetler olusturulur. Bu dosyalarda referans bilgileri
(yazar, yil, baglik) belge adi olarak kullanilir ve ideal olarak daha sonra bibliyografide tercih edilecek ayni
referans stili kullanilir. Béylece, yazarlar “Belge Sistemi”nde (“Document System”) kolayca belge adlariile
aranabilir.

3. Belge icindeki memolarda, kaynaklar ile ilgili daha fazla bilgi (belirli argimanlardan dogan sorular, bazi
yayinlarin elestirileri veya kaynagin sizin ¢alismaniz igin uygun olup olmamasi gibi) yonetilebilir.

4. "Kod Sistemi” (“Code System") raporu takip eden boéltmler ile kodlar ve onlarin ayni sirali haliyle
olusturulur. Ozetler ve atif igin uygun olan orijinal belgelerin béliimleri bu kodlarla kodlanacaktir.

5. Rapor yazildiginda, ilgili kodlar aktive edilir ve bdylece tiim kodlanmis bolimler “Geri Gagrilan Bolimler”
(“Retrieved Segments”) penceresinde bir araya getirilir.

6. Temel amag, yazmay: kolaylastirmak ve dnemli noktalari ya da referanslari kagirma riskini ortadan
kaldirmaktir. Béylece, MAXQDA kullanicinin “yazma” eylemine odaklanmasina yardimci olur.

7. lslem tamamladiktan sonra, kaynaklar, dzetler, notlar ve kodlanmis béliimler kullanicinin erisimine agik olarak
kalir. ilerleyen zamanlarda benzer bir konu lizerinde ¢alisirken, halihazirda elinizde olan bu dékiimanlar
diger referanslari ve dzetleri yeni olusturacaginiz calisma icin kullanmaya temel olusturur.
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MAXQDA ile literatlr taramalarinin olusturulmasi

“Literatlr taramasi” ne demektir? Arlene Fink’e gore, “Bir arastirma igin literatiir taramasi sistematik, agik, ve
tekrar edilebilir bir metot uygulanarak arastirmacilar, uzmanlar ve uygulayicilar tarafindan kaydedilmis ve
olusturulmus bilgiler butiinini belirlemek, degerlendirmek ve bir araya getirmektir” (Fink, 2010, p. 3).

Bu sekilde agiklandiginda bir literatir taramasi belirli bir konu veya arastirma sorusuna aciklik getirmek igin
yQrataldr. Amacg, belirli bir alanda ve konuda sliregelen bilimsel tartismalarin mevcut durumunu ortaya
koymaktir. Bununla birlikte, literatiir taramasinda bir konunun énceden belirlenmis farkli yonlerine de
odaklanilabilir. Ornegin, bir konu ile ilgili metodolojik calismalari veya teorik temelleri ele almak gibi. Bir literatiir
taramasi, bir gesit ikincil analizi temsil eder. Yeni ve bagimsiz bir arastirma olmasindan ziyade, bir alanda ¢alisiimis
bir konunun 6zel bir kapsamda incelenmesidir. Bir literatlir tarama calismasi, bir deneme yazisi gibi genelde tek
bir arastirmaci tarafindan yazilan bir incelemedir. Sistematik olarak konu ile ilgili arastirma sonuglarini sunar;
konuya iliskin farkli bakis agilarini belirler; ve spesifik bir alanda yapilmis calismalari analiz ederek 6zetler. Bir
literatlr taramasi, basit sekilde kaynaklarin listesi olmaktan ziyade her zaman agiklayici bir metindir.

LiteratUr taramalar cesitli bilimsel arastirmalarin bir parcasi (bir doktora tezi veya arastirma raporu gibi) ya da
bash basina bir inceleme seklinde olusturulabilir. Bash basina bir inceleme seklinde olmasi halinde literatir
taramalari “sistematik incelemeler” olarak adlandirilir. Sistematik incelemeler her zaman belirli bir konuya ya da
problem durumuna odaklanir ve ilgili alanyazindaki bosluklari belirlemeyi amaglar. Bilimsel aragtirmalarin bir
parcasi olan ¢alismalarda bdyle bir amag baskin olmamakla birlikte bu literatiir taramalarinin sistematik olmadigi
ya da eklektik (se¢gmeli) oldugu anlamina gelmez. Bununla birlikte, geleneksel olarak, basl basina bir inceleme
formatinda yapilan calismalar daha cok nicel yénlere odaklanir.

Literatlr taramasi olustururken takip edilecek agamalar

Fink (2019), Boland ve digerleri (2017), Hart (2017), Gough ve digerleri (2017) ve Heyvaert ve digerlerinin (2016)
yapmis olduklari galismalar i1si§inda, bir literatiir taramasinin olusturulmasi igin alti agamanin takip edilmesi
gerektigi sdylenebilir:

1. Arastirma sorularinin olusturulmasi ve literatiir taramasinin amaglarinin belirlenmesi. ilgili arastirma sorusu
literatUr taramasini etkin sekilde yiritebilmek icin tam olarak olusturulmalidir.

2. GUnUmuzde genel olarak cevrimici olan bibliyografik veri tabanlarinin segilmesi.
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Bu veri tabanlarinda arama yapmak icin kullanilacak anahtar kelimelerin belirlenmesi.
4. Uygulama ve ydntem ile ilgili kriterlerin nitelikli bilimsel literattrdn secilmesi icin uygulanmasi.

incelemenin yiiriitiilmesi. Bu asama bircok adimi kapsamaktadir: Bibliyografik verilerin ve devaminda tam
metinlerin ice aktarilmasi; yazar, yayin yili gibi degiskenlerin tanimlanmasi; 6nemli metin bélimlerinin tematik
olarak kodlanmasi, notlarin ve ézetlerin yazilmasi.

6. Sonuclarin sentezlenmesi ve incelemenin yazilmasi. Bu asamada sonuglar, nitel tanimlar formunda veya nicel
meta-analiz uygulanmasi durumunda istatistiksel karakteristik degerlerin ve élglimlerin hesaplanmasi yoluyla
sunulabilir.

MAXQDA programi tim asamalarda, 6zellikle 5. ve 6. Asamalarda belirtilen temel kaynaklarin igerik ve tematik
analizlerinin gelistirilmesinde, kullanicilara 6nemli destekler sunar. Bu tip bir ¢alisma icin MAXQDA programinin
sundugu farkli olanaklari tanitmadan énce, MAXQDA programi ile Endnote, Citavi, Mendeley, Zotero gibi referans
yonetim programlar arasindaki farkliliklar g6z 6ntinde bulundurulmalidir. Endnote ve benzeri programlar, temel
cevrimici ve cevrimdisi kaynaklarin referanslarinin bir araya getirilmesi, yonetimi ve atifi gibi islemlere olanak
tanir. Bu programlarin temel odagi bibliyografik girdinin ve bibliyografilerin bliylik sayida bilimsel dergi ve
yayinevinin farkli kurallarina uygun olarak olusturulmasi ve yénetilmesidir. Ornegin, oldukga yaygin kullanilan
programlardan biri olan Zotero programi (www.zotero.org) cevrimici kataloglardan ve Amazon gibi kitap
satiscilarinin veri tabanlarinda bibliyografik bilgileri arar ve bu bilgilerin lokal veri tabaninda saklanmasini ve

meta veri olarak anahtar kavramlar (arama kavramlan) ile kaydedilmesini miimkiin kilar. Referans listeleri daha
sonra farkl alintilama stillerine (6rnegin, oldukgca yaygin kullanilan APA stili gibi) donusturilerek disari aktarilabilir.
Referans yonetim programlar bibliyografik verilere odaklanirken, MAXQDA programi icerige odaklanarak tematik
ve sistematik kodlamaya ve igerigin nitel ve nicel olarak kodlanmasina olanak tanir. Bu nedenle, MAXQDA
programi bibliyografik verilerin toplanmasi igin kullanilan temel programlardan birisi olmadigi gibi (ki istenirse bu
mUmkdnddr) yayinlar igin referans listelerini olusturma amaci da tasimamaktadir. Fakat, daha énce de belirtildigi
Uzere, MAXQDA programi kullanicilara, referans yonetim programlarindan bibliyografik verilerin igeri aktariimasi
imkanini verir.

Simdi, MAXQDA programi ile literatiir incelemesi olusturma asamalarinin tanimina dénelim. Literatir incelemeleri
sadece belirli bir alandaki mevcut bilginin durumunu sergilemek acisindan degil, ayni zamanda ilgili arastirma
konusunun daha genis baglamda ve bilimsel ¢evrelerdeki tartismalar iginde yer edinmesi agisindan biyik 6nem
tasimaktadir. Bir literatlir incelemesi olusturmanin alti asamasi detayli olarak asagida sunulmaktadir.
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1. Asama: Literatir taramasi igin arastirma sorularinin ve amacin olusturulmasi

TUm arastirma projelerinde oldugu gibi, bir literatiir taramasi da arastirma alaninin, sorularinin ve amaglarinin
olusturulmasi ile baslar. Bununla birlikte, arastirma sorusunun olusturulmasi bir arastirma projesine kiyasla daha
genis bir kapsamda ele alinmaktadir. Eger incelemenin odagi oldukga sinirli ise, arastirma konusunun odaginda
yer alan fakat ilk etapta arama sonucunda ortaya cikmayan ilgili kaynaklar g6zden kagabilir. MAXQDA
programinda, arastirma sorusu ve amaglari, en iyi ve etkin olarak serbest memolar (Memolar > Serbest memo -
via Analysis > Free Memo) formunda sunulur. Ornegin:

Memo baghgi: Karma yéntemler arastirmasinda veri analizi ve entegrasyon (birlestirme) tizerine literatir
incelemesi

Bu literatiir incelemesinin amaci karma yéntemler arastirmasi alaninda veri analizi ve entegrasyon (birlestirme)
konularindaki tartismalarin mevcut durumunu degerlendirmektir. Karma ydntemler arastirmasi alaninda ¢ok iyi
taninan yazarlar, nicel ve nitelin birlestiriimesini (entegrasyonunu) karma yontemler arastirmasinin temel
zorluklarindan biri olarak gérmektedirler. Bu inceleme, bu konudaki en énemli degerlendirmeleri bir araya
getirmeyi amaclamaktadir. Karma yéntemler arastirmasi séylemi ingilizce olarak yiritildigi icin, sadece ingilizce
dilinde yayinlanmis olan literatir dikkate alinmalidir. Bu inceleme, 2014-2016 yillarini kapsayacak ve karma
yontemler arastirmasi alaninin lider dergisi olan Journal of Mixed Methods Research ile sinirli olacaktir.

2. Asama: Bibliyografik veritabanlarinin segimi

Bir sonraki adim, ele alinan konuyla ilgili soruya cevap sunabilecek kaynaklari belirlemeye yonelik hedefe dayall
bir arama yapmaktir. Geleneksel bir kiitiiphanede, literattir anahtar kelimeler ve anahtar kelime kataloglar ile
belirlenir, raftan alinir, ve daha sonra ¢alisma alanina veya masaya getirilir. Bilgisayarlarla calisirken ve dogru
veritabanlarinda arama yaparken, ayni prensip gecerlidir. Arastirmaci veritabanlarini ve bilimsel dergileri
kesfeder, arama sonucunda elde edilen kaynaklar listesini ve literatiir taramasina katki saglayacagini disiindigi
ve sectigi kaynaklari kaydeder.

Daha sonra, nereye ve neye bakilacagina karar vermek énemlidir. Bir diger deyisle, anahtar arama kelimelerini

belirlemek ve bibliyografik veritabanlarini segmek bir sonraki adimi olugturur. Genel olarak veritabanlari
cevrimicidir ve kamu kurumlari ile 6zel kurumlar tarafindan sunulan yizlerce veri tabani mevcuttur.

En populer uluslararasi veritabanlari sunlardir: PubMed (Tip), MEDLINE (Tip), ERIC (Egitim bilimleri), JSTOR (birgok
disiplin), LexisNexis (ekonomi ve hukuk), PsycINFO (Psikoloji), Social Science Citation Index and Sociological



18 MAXQDA ile Literatiir Taramasi

Abstracts (sosyal bilimler — veri tabarmnin original adi korunmustur) (Fink, 2019, pp. 17-21). Ayni zamanda
Springerlink gibi 6zel veri tabanlarinin, Springer International Publishing AG gibi portallarin, Sage Yayinlar gibi
dergi ve periyodik yayinlarin yer aldigi metot ve metodoloji alanlarinda vazgecilmez veritabanlarini belirtmekte
fayda vardir. Bunun étesinde diisiiniilmesi gereken bir diger nemli nokta ise sadece ingilizce dilindeki
kaynaklarin aramaya dahil edilmesi kararidir.

3. Asama: Anahtar arama kelimelerinin belirlenmesi

Buraya kadar bahsedilen adimlardan sonraki asama ise anahtar arama kelimelerinin belirlenmesidir. Bu
kavramlar tek bir kelime olabilecegi gibi birden fazla kelimenin kombinasyonu da olabilir. Neredeyse tiim
veritabanlari gelismis arama 6zelligi sunmakta ve arastirmacilara daha karmasik kosullari, 6rnegin ilgili anahtar
kelimeleri VE ve VEYA mantik islegleri ile belirtme imkani sunmaktadir.

Ornek: Journal of Mixed Methods Research (JMMR) dergisinde, “veri analizi” (“data analysis”) temasi ile ilgili
tim kayitlar igin bir arama yapilir. Arama 2014-2016 yillari ile sinirlandirilir. Diger muhtemel anahtar kelimeler “veri
cesitlemesi” (“triangulation”) ve “birlestirme” (“integration”) olabilir. Ancak buradaki 6rnekte, arama “veri analizi”
ile sinirhdir. JIMMR web sitesindeki (https://mmr.sagepub.com/search) arama 57 bulgu ile sonuglanir.

Bir sonraki asamada, websitesinde ortaya c¢ikan sonuclarin uygunlugu yine site tGzerinde kontrol edilebilir veya
arama sonunda elde edilen sonuclarin tam listesi MAXQDA programina aktarilarak orada kontrol edilebilir. Bu
ornekte, MAXQDA programina sonuglarin aktarilarak kontrol edilmesi daha etkin bir yoldur. Sage Yayinlari
websitesinden disa aktarirken dikkat edilmesi gereken en 6nemli husus hem referansin hem de c¢alisma 6zetinin
disa aktarildigindan emin olmaktir. RIS formati mevcut formatlar listesinden segilmelidir. ilgili dosya, MAXQDA
programina meniide yer alan iceri aktar > Referans Yonetici Verisi (Import > Reference Manager Data)
fonksiyonu ile aktanhr.

4. Asama: Nitelikli bilimsel literattiriin se¢imi icin uygulama ve yontem ile ilgili kriterlerin uygulanmasi

Bu asama ilgili literattiriin segcimine 6nem vermeyi gerektirir. Bir diger deyisle, veri tabani aramasinda bulunan
literatlr bu asamada 6zel olarak arastirma sorusunun daha dar bir alanina mi karsilik geliyor yoksa mevcut
haliyle literatlr incelemesinin tim amaclarini karsiliyor mu sorularina cevap aramayi amaglar.

Bu secim sUrecinin uygulama ve yontem ile ilgili kriterleri mutlaka kayit altina alinmalidir. Uygulama ile ilgili
kriterler pratik erisilebilirlik, dil ve yayin tipi ile ilgilidir. Ornegin, Avrupa’da cevresel farkindalik ile ilgili bir calisma
icin, sadece bircok yaygin dilde sonuglar, muhtemelen sadece ingilizce olanlar, diisiiniilebilir. Dahasi, arama
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sadece en 6nemli sosyal bilimler dergileri ile sinirlandirilabilir. Bu tarama igin ydntem ile ilgili kriterler, 6rnegin,

orneklemin kalitesi ve bicimi ya da ilgili calismayi yiriten enstitiiniin “ciddiyeti” ile ilgili olabilir. Yontem ile ilgili

gerekceler arasinda gevrimici anketlere dayal kaynaklarin dahil edilmemesi yer alabilir. Bunun nedeni olarak da

kolay ulasilabilir durum 6rneklemesi ile veri toplanmis olmasi gosterilebilir.

Daha 6nce verilen karma yontemler arastirmasi 6rneginde veri analizinin literatiir incelemesi érnegi igin, tim

bibliyografik arama sonuclari MAXQDA programinda ice aktarilmisti. Béylece kaynaklarin “Belge Sistemi”

(“Document System”) kisminda listelenmesi miimkiin hale gelir. Asagida yer alan gérsel, MAXQDA programinin bu

bilgiler ice aktarildiktan sonra nasil gérindiigiini géstermektedir.
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“Journal of Mixed Methods Research” dergisinde ortaya ¢ikan arama sonuglarinin RIS dosyasi olarak MAXQDA programina
aktarilmis sekli

RIS format etiketleri “Kod Sistemi”nde (“Code System”) bulunabilir. Buradaki 6rnekte goruldigi tzere
toplam 57 kaynaktan sadece 49'u icin 6zet bulunmaktadir. Belge degiskenleri listesinin (the list of document
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variables) gorildigu sag taraftaki pencerede bes etiketin (yayin turi [type of publication], yazar [author], baglik
[title], kayit numarasi [ID], yayin yili [year of publication]) ayni zamanda degisken olarak sonraki segimler igin
mevcut oldugu gérilmektedir.

Bir sonraki adim, kaynagin literatiir taramasina uygun olup olmadigini belirlemek icin sistematik olarak her 6zeti
okumaktir. “Belge Sistemi” (“Document System”) icinde iki veya daha fazla yeni belge grubu olusturulmasi,

elde edilen sonuclarin ilgili olup olmadigina gére diizenlenebilmesi icin dnerilir. Belge gruplarinin isimleri
islevlerini ifade etmelidir. Ornegin, “Uygun kaynaklar” ve “Az uygun kaynaklar” gibi. ilgili literatiir taramasina
katkida bulunmayan kaynaklar hemen silinebilir. Ozetleri okurken bir kaynagin nereye atanacagina iliskin emin
olunamiyorsa, tam metinler ilgili linkteki “DO_DOI“ etiketi veya “UR_Web/URL” etiketi ile olusturulmus

kodlara tiklanarak “Belge Tarayici”sindan erisilebilir. Bu link Sage Yayinlari veri tabaninda yer alan ve tam metne
yonlendiren bilgi sayfasini agacaktir (veri tabanina kitiiphaneniz araciligiyla erisiminizin oldugunu varsayryoruz).
Tam metni okumak ilgili kaynagin uygun veya az uygun kaynak olup olmadigina iliskin siniflandirmay yapmak
adina saglam dayanaklar gelistirmeyi mimkiin kilar.

Kullaniciya se¢im yapma veya karsilastirma olanagi saglayan ve trendleri farketmesini saglayan diger degiskenler
literatlr taramasinin bu asamasinda tanimlanir. Ornegin, “RIS_Year” (“RIS_Yil”) degiskeni, kaynaklarin yila gére
dagilimini gésteren bir tablo veya cizelge olusturulmasina olanak tanir.

Veri tabani taramasi ile elde edilen sonuclarin yani sira literatiir taramasina dahil edilmesi gereken baska temel
kaynaklar olabilir. Prensipte, tim kaynak turleri, ses ve video kayitlari dahil, MAXQDA programinda ice
aktarilabilir. Kitaplar gibi 6diing alinamayan kaynaklar sadece taranmis kopyalar olarak erisime acik olabilir.
Boylesi arama yoluyla taranmis kaynaklar da literatiir taramasina dahil edilebilir.

Taranmis kaynaklar icin ipuglari: Uygun bir kaynagin elektronik versiyonu erisime acik degilse, tek secenek taranmis
sayfalan kullanmaktir. Tarama islemi ile bir PDF veya fotograf dosyasi elde edersiniz. Adobe Acrobat gibi bir
programi kullanarak, optik karakter tanima (OCR) metin algilama prosediriini uygulayabilirsiniz. Bu adim 6nemle
tavsiye edilir ¢ciinkl devaminda yapilacak olan aramalar, MAXDictio dahil olmak tizere MAXQDA programinda yer
alan metin icinde kelimeler veya tim kelime fonksiyonlarinin gergeklestirilebilmesi icin dnemlidir.

Eger kaynaklar uygunluklarina gore siniflandiriimissa, 6zellikle uygun olan kaynaklar tam metin olarak ice
aktarilabilir. Yeni belge grubu (6rnegin, “Temel literatir” gibi) olusturmak ve tam metinleri indirip bu dosyaya
kaydetmek en iyi uygulamadir. ideal olarak, tam metin ve bibliyografik referans su adimlarla iliskilendirilmelidir:
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1. Tam metni aciniz.
2. Bibliyografik referansi “ikinci Belge Tarayicisi”nda (“Second Document Browser”) aciniz.

3. Tam metinde ilk kelimeyi (veya ilk paragrafi) vurgulayiniz ve Dahili Baglanti Ekle (Insert Internal Link)
fonksiyonunu icerik mendstinden seciniz.

4. Bibliyografik referansta ilk kelimeyi (veya ilk paragrafi) vurgulayiniz ve Dahili Baglanti Ekle (Insert Internal
Link) fonksiyonunu icerik menUsinden seciniz.

Basta 6zel veri tabanlari olmak zere birgok veri tabani igin, indirme islemi sadece gerekli yetkiye sahip olmaniz
halinde s6z konusu olabilir. Bircok Universitede bu olanak mevcuttur ve Universitenin tim Uyeleri igin bu
kaynaklar erisime acik olabilir. Universite agi tizerinden VPN ile giris yapmak gerekebilir.

5. Asama: incelemeyi yiiriitme

Bir literatlr taramasini yiriitme sireci arastirma sorularinin dogasina, incelemenin amaglarina ve kaynaklarin
cesitliligine bagh olarak farklilik gésterebilmektedir. Bununla birlikte, siireg, literatiir taramasinin hazirhigi igin sahip
olunan zaman dilimine de baghdir. Eger zaman kisith ise, materyali sinirlandirmak ve uygulama ve yontem ile ilgili
kriterlerin olusturulmasini sinirlandirmak zorunda kalirsiniz (Asama 4’e bakiniz). Bu durumda, taramaniz detayh
tam metinlere degil, 6zetlere dayali olacaktir. Bahsedecegimiz secenekler MAXQDA programinin literatiir taramasi
yUrUtebilmek icin 6nerdigi olasi yollardan birkagidir:

Kelime bulutlari ile calismak

Bir metnin ve kullanilan anahtar kelimelerin merkezinde olusan temalar nelerdir? Bunlar, kolaylikla tam metinde
sag tiklayip Kelime Bulutu (Word Cloud ) segenegini kullanarak kesfedilebilir. Alternatif olarak, bibliyografik
verinin belirli kisimlari (bashklar veya dzetler) icin ilgili bélimleri geri ¢cagirarak ve “Geri Cagrilan Bélimler”
(“Retrieved Segments”) penceresindeki kelime bulutu fonksiyonunu kullanarak bir kelime bulutu
olusturabilirsiniz. Anlamsiz kelimeler veya literatiir taramasi kapsaminda ilgili olmayan kelimeler harig listesine
eklenebilir.

Tam metni inceleme ve memolarla calisma

Hemen hemen her konuda erisime acik yayinlarin cok sayida oldugu gériisiinden hareketle, bir kitabin ya da
dergide yayinlanmis makalenin tamamini okumak ¢ogunlukla giictir. “Belge Tarayicisi

” (ll

Document Browser”)
icinde icerik arama 6zelligini kullanarak, anahtar kelimelerin ilgili metinde olup olmama durumunu 6zel olarak
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arayabilirsiniz. Bu arama, detayli okuma gerektiren yogun metinleri ciddi miktarda azaltma islevi gorur. Fikirler ve
temel varsayimlarin yaninda ortaya gikan sorular, daha sonra memo olarak ilgili metinlere eklenebilir. Bir metnin
genel degerlendirme ve elestiriimesi belge memolari olarak “Belge Sistemi” (“Document System”) icinde kayit
altina alinabilir.

Metinlerdeki 6nemli kisimlari vurgulama

Bir metni okumak ve 6nemli noktalarin altini cizmek yaygin olarak kullanilan bir uygulamadir. MAXQDA
programini kullanarak literatiir taramalarinda ayni yaklasimi uygulamak miimkindir. MAXQDA, kullanicilara
metin verilerini renkli kodlayabilmek icin bes farkl renk secenegi sunmaktadir. isaretlenmis olan bélimlere daha
sonraki bir zaman diliminde kolaylikla erisilebilir. Bazi durumlarda, metinleri renkli kodlamadan ziyade tematik
kodlamak daha faydali olabilir.

Kaynaklarda kullanilan kavramlarin ve kelimelerin frekanslarini (kullanim sikliklarini) inceleme

Sozclk frekansi fonksiyonunu (MAXDictio sekmesinin bir 6zelligi) kullanarak bir veya daha fazla belge icinde
gecen kelimelerin frekanslarini analiz edebilirsiniz. Bununla birlikte, farklilastirilmis bir kelimenin frekans analizi de
belgelerde, belge gruplarinda ve kiimelerde gergeklestirilebilir. Kelime bulutlarinda oldugu gibi, anlamsiz
kelimeler haric listesine eklenerek analiz digi birakilabilir.

Ozetleri yazma

Metin &zetleme ve ilging metinleri disa aktarma literatiir taramasinin en klasik tekniklerinden biridir. MAXQDA
programinda, “Ozetler” adinda bir belge grubu tiim ézetlerdeki ve belgelerdeki alintilarin kayit edilebilmesi igin
oncelikle tanimlanmalidir. Daha sonra, Yeni Metin Belgesi (New Text Document) belge sistemi icinde belge
grubu menUstnden sag tiklayarak segilir. Boylelikle, icerisine dzetleri yazmaya bagslayabileceginiz yeni bir belge
“Belge Tarayicisi” (“Document Browser”) alaninda diizenleme modunda olusturulacaktir. Eger tam metin ige
aktariimissa, tam metin “Belgeyi ikinci Belge Tarayicisinda Ag” (“Second Document Browser”) segenegi
kullanilarak ikinci bir tarayicida agilabilir. Bu fonksiyon, kullanicinin es zamanl olarak hem kaynak metni okumasi
hem de 6zeti yazmasina olanak tanir. Belge linkleri kullanilarak metnin belirli bir bélimdi ile ilgili 6zet birbirlerine
baglanabilir. Ozetin adlandirilmasi sirasinda yazara ve yayin yilina yer verilmeli ve dahasi 6zet, daha 6nce
belirtilen asamalar takip edilerek bibliyografik referansa baglanmalidir.
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Metin bolimlerinin otomatik kodlanmasi

Metin ilgin¢ anahtar kelimeler icin aranabilir ve elde edilen sonuclar otomatik olarak Analiz > S6zctiksel
Arama (Analysis > Lexical search) fonksiyonu kullanilarak kodlanabilir. Kodlanacak olan metinlerin gesitliligi
kullanici tarafindan serbest sekilde (arama sonuglari, cimle, birkag ctimle, paragraf) secilebilir. Otomatik
kodlamayi takiben, kodlanmis bélimler ¢agrilip daha detayh kesfedilebilir.

Onemli metinlerin manuel/elle tematik kodlanmasi

ilgili metinlerin kodlanmasi ana metin (dergi makalesi) erisime acik oldugunda miimkiindiir. Bu durumda,
inceleme kapsamindaki arastirma sorularina miamkin oldugunca en yakin tematik kodlarla ¢alismak tavsiye edilir.
Ozel etiketleme sayesinde, daha sonra alinti yapmaya uygun olan metinleri etiketleyebilirsiniz. Bu amag igin, 6zel
bir kod (6rnegin “Alintilama icin uygun”) tanimlanabilir. Alternatif olarak, yorum fonksiyonu veya agirlik skoru
kullanilabilir. Her bir kodlanmis bélim icin, kisa bir yorum (bu durumda, 6rnegin, “Alinti”) eklenebilir. Daha sonra,
Kodlu Bélimlere Genel Bakis (Overview of Coded Segments) bélimiinden (Raporlar menisiinde yer alir) tiim
muhtemel alintilarin bir arada yer aldig situna gore siralama yapabilirsiniz. Ayni zamanda, kodlanmis herhangi
bir bdltime bir agirlik skoru atamak mumkiindir. Ardindan, secilen temanin veya spesifik agirlik skoru atanan
kodlanmis metinleri geri cagirabilirsiniz.

Farkli boyutlari ayirt etme, kodlama ve istatistiksel olarak analiz etme

LiteratUrdeki spesifik bir icerik alaniigin, (6rnegin arastirma deseni) spesifik boyutlar alt kodlar olarak
tanimlanabilir. Ornek verecek olursak “Agiklayici sirali desen” (Explanatory sequential design), “Kesfedici siral
desen” (Exploratory sequential design) veya “Eszamanli desen” (Convergent design) gibi. “Kodlar” menisinde
yer alan Alt Kodlann istatistigi (Subcode Statistics) secenegini kullanarak farkli desen tiplerinin frekanslarinin
belirlenmesi ve tablo veya grafik olarak gdsterilmesi mimkin olabilir.

Temalarin ve kaynaklarin gérsel sunumu

MAXQDA programinin gorsel araglari literatlir taramalari igin de oldukga etkin sekilde kullanilabilir. Burada ilgili
metinlerin elle veya anahtar kelimeler Gzerinden otomatik kodlama &6zelligi kullanilarak kodlandigini kabul
ediyoruz.

e Kod Matris Tarayicisi (Gérsel Araglar menusii — Code Matrix Browser) kapsanan temalari ve her biri igin
kodlanmis metin frekanslarini karsilastirmali bir tablo ile sergiler.
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e Kod iliskiler Tarayicisi (Gérsel Araglar meniisii — Code Relations Browser) karsilastirmali bir tabloda
gruplanan temalarin es zamanl ortaya gikma durumlarini sergiler.

e Yeni Belge Modeli (Tek Vaka Modeli — Single-Case Model) (Gérsel Araclar > MAXMaps/ Visual Tools >
MAXMaps menlsinde bulunur) kodlanmis temalari ve segilmis bir kaynak icin onlarin sikligini sematik bir
gorselle sunar.

e Yeni Kod Modeli (Tek Vaka Modeli — Single-Code Model) (Gérsel Araclar > MAXMaps mendstnde
bulunur) secilmis tema, onun kodlanmis béliimleri, kodun memosu ve memonun atandigi ilgili kodu sematik
olarak gorsellestirir.

Tematik Ozetlerin yazilmasi ve 6zet tablolarinin olusturulmasi

Bu teknik MAXQDA programinin Analiz > Ozet Kilavuzu (Analysis > Summary Grid) fonksiyonunu kullanir. Bu
fonksiyon temalarin olusturulmasini kolaylastirir ve onlari karsilastirmali tablolar halinde sunar (“Ozet
Tablolar”/“Summary Tables”). Bu teknigi kullanabilmek icin ilgili metinlerin dnceden tematik olarak kodlanmis
olmasi gereklidir.

Temalarin nicel degerlendirilmesi

Nicel yonler literatir taramasi icin 6nem teskil edebilir. Ornegin, degiskenlere (6r., yayin yili) gére kaynaklar
saymak ve siralamak mimkiindiir ve “ilgili kaynaklar zamanla nasil dagilim géstermistir?” veya “Veri analizi ve
birlestirilmesi konusuna yénelik calismalar ilgili zaman diliminde artmis veya azalmis midir?” sorularina cevap
verilebilir. istatistiksel tablolar bagil ve mutlak frekanslarin yani sira tematik kodlar ve alt kodlari i¢in gubuk grafik
ve dairesel grafik seklinde MAXQDA programinda olusturulabilir. Korelasyon analizi gibi daha kompleks analizler
MAXQDA programinin STATS (istatistik) modUlU ile gerceklestirilebilir.

6. Asama: Sonuglari sentezleme ve incelemeyi yazma

isin cogu ilk bes asamada tamamlandiktan sonra, bulgularinizi 6zetleme ve yorumlama zamanidir. incelemenizi
yazarken, ilk bes asama icin yapilan is ve 6nhazirlik 6nem tagimaktadir. Bu demektir ki, yapilan 6n isten elde edilen
sonuglar sizi iyi organize edilmis bir metin yazmaya hazirlamalidir. Bir diger deyisle, asama 5 ve 6’da hazirlamis
oldugunuz memolarin yani sira 6zet tablolari gibi gérsel araclari g6z éniinde bulundurarak yazma siirecinizi
baglatabilirsiniz.

iki tip literatiir taramasi vardir:
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Fink

Sonuclarin nitel tanimi formunda bir inceleme (betimsel literatir taramasi); nadiren nicel sonuclarin (r.,
kaynaklarin sayisi, zamanla dagilimi, mevcut trendler, alt konularin frekansi gibi) da dahil edildigi érnekleri
mevcuttur. Ancak odagi her zaman niteldir.

istatistiksel parametrelerin ve dlceklerin hesaplandig nicel meta-analiz formunda literatlr taramas.
Burada, bir etkinligin cesitli dizeylerindeki ortalama korelasyonlarinin hesaplandigi ve raporlandigi tutum-
davranis arastirmalarinin meta-analizi calismalarina benzer sekilde istatistiksel prosedurlerin sonuclarina
odaklanihr.

‘e (2019) gore, her iki literatlr taramasi tiri de su dort bélimi icermelidir:
Taramanin genel amaci ve hedefleri

Metot ve drneklem

Sonuclar

Tartisma

Nicel meta-analiz calismalarinda, metot bolim kullanilan istatistiksel metotun detaylari ve tanimini kapsayacak

sekilde 6zel olarak genisletilmelidir.

incelemenizi yazarken, asagida belirtilen MAXQDA araglari size biiyiik dlgtide kolaylik saglayabilir:

Sozclksel Arama ve Gelismis Kodlama Sorgusu (Simple and the Complex Coding Query): Bu iki 6zellik ile
onceden uygun alintilar igin etiketlenmis ve siniflandiriimis olan metinleri ve metin bélimlerini geri
cagirabilirsiniz.

Memolar (Memos): Ozellikle, incelemenin 5. asamasinda yazilmis olan serbest memolar son seklini

vereceginiz metne ilgili pasajlari ve metinleri kopyalama imkani sunar.
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Ozet Tablolari (Summary tables): Kaynaklar igin yogunlastiriimis sekilde bir araya getirme, etkin olarak
karsilastirma ve sunma kolayligi saglamaktadir. Ayrica literatiir taramaniza 6zet tablolarini dahil etmeniz bu
fonksiyonu kullanarak mimkdndur.

MAXDictio icindeki kelime frekansi fonksiyonu: Bu ézelligi kullanarak spesifik arama kelimelerinin ve
anlamsal baglamlarinin kullanimini sunabilirsiniz.

MAXMaps icindeki grafiksel gosterim secenekleri: Bu fonksiyon 6zellikle kavram haritalarinin
olusturulmasina olanak tanir.
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Okudugunuz igin tesekkiirler

Bu kilavuzu begendiginizi umariz. Elbette, MAXQDA daha fazlasini sizlere sunuyor. MAXQDA ile sizler:
e Ses ve video dosyalarinizin transkripsiyonunu yapabilirsiniz.

e Twitter ve YouTube verilerini iceri aktararak analiz edebilirsiniz.

e Odak grup goriismelerini analiz edebilirsiniz.

e Verileri gorsellestirebilirsiniz.

e Raporlar olusturabilirsiniz.

e Nicel icerik analizi ve cok daha fazlasini yapabilirsiniz.

MAXQDA programinin pek ¢ok 6zelligi ve farkli fonksiyonlari hakkinda daha fazlasini 6grenmek igin
www.maxqda.com adresini ziyaret edebilirsiniz.

Kongre: MQIC — MAXQDA International Conference (MAXQDA Uluslararasi Konferansi)

Her yil dizenlenen MAXQDA Uluslararasi Konferansi diinyanin dért bir yanindan MAXQDA kullanicilarini bir araya
getiriyor. Konferans calistaylar, poster sunumlari, en iyi pratikler grup oturumlari ve MAXQDA ve karma
yontemler arastirmasi egitimleri olmak tizere katilimcilara ¢ok genis yelpazede bir program sunuyor.

Konferans hakkinda daha fazla bilgi edinmek icin www.mgic-berlin.com adresini ziyaret edebilirsiniz.


http://www.maxqda.com/
http://www.mqic-berlin.com/
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